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SPECIAL NOTICES

The software and this Installation Guide are exclusive copyrights of Yamaha Corporation.

Use of the software and this guide is governed by the SOFTWARE LICENSING AGREEMENT which the purchaser fully agrees to upon breaking the seal of
the software packaging. (Please read carefully the AGREEMENT at the end of this guide before installing the application.)

Copying of the software or reproduction of this guide in whole or in part by any means is expressly forbidden without the written consent of the manufacturer.
Yamaha makes no representations or warranties with regard to the use of the software and documentation and cannot be held responsible for the results of the use
of this guide and the software.

This disc is a CD-ROM. Do not attempt to play the disc on an audio CD player. Doing so may result in irreparable damage to your audio CD player.

Copying of the commercially available music data is strictly prohibited except for your personal use.

The company names and product names in this Installation Guide are the trademarks or registered trademarks of their respective companies.

Future upgrades of application and system software and any changes in specifications and functions will be announced separately.

Software such as the USB MIDI driver may be revised and updated without prior notice. Make sure to check and download the latest version of the software
from the following site.

http://www.yamahasynth.com/down/index.htm

Depending on the version of your operating system, the screen shots and messages shown in this guide may differ to those that you see on your computer screen.

BESONDERE HINWEISE

Dieses Programm und diese Installationsanleitung sind im Sinne des Urheberrechts alleiniges Eigentum der Yamaha Corporation.

Die Benutzung des Programms und dieser Anleitung unterliegt der SOFTWARE-LIZENZVEREINBARUNG, mit der sich der Erwerber durch Offnen des
Siegels der Programmverpackung uneingeschrinkt einverstanden erklirt. (Bitte lesen Sie die VEREINBARUNG am Ende dieser Anleitung vor Installation
der Anwendung sorgfiltig durch.)

Das Kopieren der Software und die Reproduktion dieser Anleitung, in welcher Form auch immer, in Teilen oder als Ganzes, sind nur mit schriftlicher
Genehmigung des Herstellers erlaubt und sonst ausdriicklich verboten.

Yamaha leistet keinerlei Garantie hinsichtlich der Benutzung des Programms und der zugehorigen Dokumentation und iibernimmt keine Verantwortung fiir die
Ergebnisse der Benutzung dieser Anleitung oder des Programms.

Bei dieser CD handelt es sich um eine CD-ROM. Versuchen Sie bitte nicht, diese CD-ROM auf einem Audio-CD-Player abzuspielen, da dies zu irreparablen
Schiden am Audio-CD-Player fiihren kann.

Das Kopieren im Handel erhéltlicher Musikdaten ist nur fiir Thren Privatgebrauch zuldssig und sonst streng untersagt.

Die in dieser Installationsanleitung erwéhnten Firmen- und Produktnamen sind Warenzeichen bzw. eingetragene Warenzeichen der betreffenden Firmen.
Zukiinftige Aktualisierungen von Anwendungs- und Systemsoftware sowie jede Anderung der technischen Daten und Funktionen werden separat bekanntge geben.
Software wie z.B. der USB MIDI Driver kann ohne vorherige Benachrichtigung iiberarbeitet und aktualisiert werden. Achten Sie darauf, auf der folgenden
Website nach der neuesten Version der Software zu suchen und sie herunterzuladen.

http://www.yamahasynth.com/down/index.htm

Je nach der Version Ihres Betriebssystems unterscheiden sich die hier dargestellten Screenshots und Meldungen von der tatsdchlichen Anzeige auf Threm
Computermonitor.

REMARQUES PARTICULIERES

Les droits d’auteurs (copyright) de ce logiciel et de ce manuel d’installation appartiennent exclusivement a Yamaha Corporation.
L’usage de ce logiciel et de ce manuel est défini par ’accord de licence auquel I’acheteur déclare souscrire sans réserve lorsqu’il ouvre le sceau de 1’emballage
du logiciel. (Veuillez donc lire attentivement 1’accord de licence du logiciel situé a la fin de ce manuel avant d’installer le logiciel.)

Toute copie du logiciel et toute reproduction totale ou partielle de ce manuel, par quel moyen que ce soit, est expressément interdite sans 1’autorisation écrite du fabricant.

Yamaha n’offre aucune garantie en ce qui concerne 1’utilisation du logiciel et de la documentation. Yamaha ne peut en aucun cas &tre tenu responsable des
dommages éventuels résultant de I’utilisation de ce manuel et de ce logiciel.

Ce disque est un CD-ROM. N’essayez donc pas de I’insérer dans un lecteur de CD audio. Vous risqueriez d’endommager ce dernier de maniere irréversible.
Toute copie de données musicales commercialisées est formellement interdite, sauf pour usage personnel.

Les noms des firmes et des produits apparaissant dans ce manuel d’installation sont des marques commerciales ou des marques déposées appartenant a leurs
détenteurs respectifs.

Les remises a jour du programme et du systeme ainsi que toute modification des caractéristiques et fonctions seront annoncées séparément.

Les logiciels tels que le pilote USB MIDI sont susceptibles d’étre révisés et mis a jour sans avertissement préalable. Veuillez toujours a vérifier la version du
logiciel utilisée et a télécharger la derniere version en date sur le site suivant:

http://www.yamahasynth.com/down/index.htm

En fonction de la version du systéme d’exploitation que vous utilisez, les captures d’écran et les messages qui figurent dans ce manuel peuvent différer de ceux
qui apparaissent sur I’écran de votre ordinateur.

AVISOS ESPECIALES

El copyright del software y de la guia de instalacion es propiedad exclusiva de Yamaha Corporation.

La utilizacién de este software y de esta guia debe ajustarse al CONTRATO PARA USO DE SOFTWARE BAJO LICENCIA, con el que el comprador manifiesta
su total conformidad al abrir el paquete de software. (Lea detenidamente el CONTRATO que se incluye al final de esta guia antes de instalar la aplicacion).

La copia del software o la reproduccion total o parcial de este manual por cualquier medio sin la autorizacion escrita del fabricante estd expresamente prohibida.
Yamaha no asume responsabilidad alguna ni ofrece garantia alguna en relacion con el uso del software y de la documentacion, y no puede ser declarada
responsable de los resultados de la utilizacién de este manual ni del software.

Este disco es un CD-ROM. No intente reproducirlo en un reproductor de CD de audio, porque al hacerlo se podrian causar dafios irreparables en el reproductor.
Queda terminantemente prohibida la copia de datos musicales disponibles comercialmente, excepto para uso personal.

Los nombres de compaiifas y de productos que aparecen en esta guia de instalacién son marcas o marcas registradas de sus respectivas compaiias.

Las futuras actualizaciones de la aplicacion y del software del sistema, y cualquier cambio en las especificaciones y funciones, se anunciardn independientemente.

Segtn las versiones del sistema operativo, las capturas de pantalla y los mensajes que aparecen en esta gufa podrian diferir de los que aparecen en la pantalla del ordenador

Espaiiol
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For Windows Users

About Open Plug-in Technology

You can start the File Utility software as either a stand-alone software or a plug-in application in the Open Plug-in Technology compatible
application.
Refer to the owner's manual of the client application (sequencer, etc.) for details on using the File Utility as a plug-in software.

Open Plug-in Technology (OPT) is a newly developed software format that allows control over MIDI devices from a music software
sequencer. For example, this allows you to start up and operate various parts of your music system, such as plug-in board editors, and
mixing control editors - directly from an OPT-compatible sequencer, without having to use each separately. This also makes it unneces-
sary to set MIDI drivers for each application, streamlining your music production system and making all operations more convenient
and seamless.

About the OPT Levels

The client application and its compatibility with OPT can be divided into three levels, as shown below.

wointee,  Level 1 — OPT Panels provides basic support for opening and displaying OPT control panels that can transmit data via

§7 )% the clients’ external MIDI ports.

pAnNELs  Ilypically this will allow basic hardware editor control panels to operate properly.

awointee,  Level 2 — OPT Processors provides support for real-time MIDI processors and panel automation.

2o Typically this will allow both real-time and offline MIDI effects (e.g. Arpeggiators, transposers etc.) to operate properly

PROCESSORS and supply automation to OPT panels.

ewsinTeos, Level 3 — OPT Views provides support for edit views and MIDI processors/panels that require direct access to client
5@, & sequencer storage structures. Typically this will allow sophisticated MIDI edit views to be supported (e.g. List editors,

ViEws Auto Accompaniment, Data Checkers etc.).

OPT Level Implementation for the File Utility

This chart shows the OPT-compatibility of the File Utility.

File Utility operation

OPT levels of the client application
Operation support Operation limits

\
/

VIEWS (Level3) o) Yes None

\'

PROCESSORS (Level2) é’@ Yes None

PANELS (Levell) = No —

#1 NoTE
« Certain operations may not work as expected if there is no corresponding function in the client application (sequencer, etc.). The highest level of implementation
for the client application is indicated in the OPT logo (which appears along with the version information in the application).
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For Windows Users

Software Installation

# NOTE

« For details about the application software which has no installation guide
described below, refer to the online manual of each software.

Uninstall (Removing the installed application)

You can remove the installed application software.

Select [START] — [Settings] — [Control Panel] — [Add/
Remove Programs] — [Install/Uninstall], then select the
application to be removed and click [Add/Remove...].
Follow the on-screen instructions to uninstall the application.

# NOTE

« The button names or menus may differ depending on the computer
OS.

— Windows 98/Me users See below.

— Windows 2000 users See page 4.

— Windows XP users See page 5.
#7 NOTE

« Before you install the USB MIDI driver, you can minimize the possibility of
problems by putting your computer in the following state.

« Close all applications and windows that you are not using.
« Disconnect all cables from the MIDI instrument except for the cable
whose driver you are installing.

Installing the driver on a Windows 98/Me system

H Acrobat Reader

In order to view the electronic (PDF) manuals included with each
application, you’ll need to install Acrobat Reader.

#7 NOTE

« If an older version of Acrobat Reader is installed on your PC, you'll need to
uninstall it before proceeding.

' Double-click on the “Acroread_" folder.
Four different language folders will be displayed.

2 Select the language you want to use and double-click on its
folder.
The file “ar***.exe” file will be displayed. (“***” indicates
the selected language.)

3 Double-click on “ar***.exe.”
Acrobat Reader Setup Dialog box will be displayed.

4 Execute the installation by following the on-screen directions.

After installation is complete, the Acrobat folder appears on your
PC (in Program Files, as the default).

For information on using the Acrobat Reader, refer to the Reader
Guide in the Help menu.

Bl USB MIDI Driver

To operate the MIDI instrument from your computer via USB,
you’ll need to install the appropriate driver software.

The USB-MIDI driver is software that transfers MIDI data back
and forth between sequence software and the MIDI instrument via
a USB cable.

Computer

Sequence MIDI instrument

Software

I
[

USB cable 0o |:| -

o= = Jp—

e} gm##go j [— O

Driver

o

' Start the computer.
2 Insert the included CD-ROM into the CD-ROM drive.

3 Make sure the POWER switch on the MIDI instrument is set
to OFF and use the USB cable to connect the USB terminal of
the computer to the USB terminal of the MIDI instrument.
When the MIDI instrument is turned on, the computer auto-
matically displays the “Add New Hardware Wizard.” If the
Add New Hardware Wizard does not appear, click “Add New
Hardware” in the Control Panel.

In Windows Me, check the radio button to the left of “Auto-
matic search for a better driver (Recommended)” and click
[Next]. The system automatically starts searching and install-
ing the driver. Proceed to step #8. If the system does not
detect the driver, select “Specify the location of the driver
(Advanced)” and specify the CD-ROM drive’s “USBdrv_" to
install the driver.

Windows 98

This wizard searches for new drivers for:

USE Device

A device driver is a software program that makes a
hardware device work,

< Bk | Heats || Cancel

Windows Me

Add New Hardware Wizard

Windows has found the following new hardware:
USE Device
Windows can automatically search for and install software

that supparts your hardware. IF your hardware came with
installation media, insert it now and click Next

‘what would you like ta do?

& Butomalic search for a better diiver [Hecommended}

" Specify the lacation of the driver [Advanced)

< Back I Mext > I Cancel
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For Windows Users

Click [Next].
The window below enables you to select the search method.

Add New Hardware Wizard

Wwhat do you want Windows to do?

s earch for the best driver for your device.
(EE e T

" Display a list of all the diivers in a specific
lncation, so you can select the driver you want,

< Back I Next > I Cancel |

Check the radio button to the left of “Search for the best
driver for your device. (Recommended).” Click [Next].

The window that enables you to select a location in which to
install the driver appears.

Check the “Specify a location” box, click “Browse..”, then
specify the “USBdrv_" directory of the CD-ROM drive (such
as D\USBdrv_\) and continue the installation.

g 1) NOTE

« The system may ask you to insert a Windows CD-ROM while it
checks for the driver. Specify the “USBdrv_" directory of the CD-
ROM drive (such as D:\USBdrv_\) and continue the installation.

When the system detects the driver on the CD-ROM and is
ready for installation, it displays the following screen.

Make sure that the “YAMAHA USB MIDI Driver” is listed,
and click [Next]. The system starts the installation.

Add New Hardware Wizard

“windows driver file search for the device:

AMAHA USE MIDI Driver

“windows is now ready to install the best driver for this
device. Click Back to select a different driver, or click Mest
ta continue.

Location of diver.

@ D4 USBDRV A CWP-206 INF

< Back Cancel

g D) NOTE

« The location of the driver may differ depending on the particular
model or computer platform used.

When the installation is complete, the following screen
appears. Click [Finish].

Z7 NOTE

« Some computers may take about ten seconds to show this screen
after the installation is complete.

Windows 98

Add New Hardware Wizard

@ ‘YaMaHA USE MIDI Diiver

Windows has finished instaling the software that your new
hardware device requires,

Cancel

ik [ERE

Windows Me

Add New Hardware Wizard

@ TAMAHA LUSE MIDI Driver

‘windaws has finished instaling the new hardvare device.

< Eack = lesh = Caticel

The driver has been installed.

Installing the driver on a Windows 2000 system

' Start the computer and use the “Administrator” account to log
into Windows 2000.

2 Select [My Computer] — [Control Panel] — [System] —
[Hardware] — [Driver Signing] — [File Signature Verifica-
tion], and check the radio button to the left of “Ignore -Install
all files, regardless of file signature” and click [OK].

3 Insert the included CD-ROM into the CD-ROM drive.

Make sure the POWER switch on the MIDI instrument is set
to OFF and use the USB cable to connect the USB terminal of
the computer to the USB terminal of the MIDI instrument.
When the MIDI instrument is turned on, the computer auto-
matically displays the “Found New Hardware Wizard.” Click
[Next].

5 Check the radio button to the left of “Search for a suitable
driver for my device. (Recommended).” Click [Next].
The window that appears enables you to select a location in
which to install the driver.

6 Check the “CD-ROM drives” box and uncheck all other
items. Click [Next].

#) NOTE

« The system may ask you to insert a Windows CD-ROM while it
checks for the driver. Specify the “USBdrv2k_" directory of the CD-
ROM drive (such as D:\USBdrv2k_\) and continue the installation.

7 When the installation is complete, the system displays “Com-
pleting the Found New Hardware Wizard.” Click [Finish].

g D) NOTE

« Some computers may take about ten seconds to show this screen
after the installation is complete.

8 Restart the computer.
The driver has been installed.
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For Windows Users

Installing the driver on a Windows XP system

, Start the computer.

D select [Start] — [Control Panel].
If the control panel appears as shown below, click “Switch to
Classic View” in the upper left of the window.
All control panels and icons will be displayed.

# ControlPanel

Fle Edi Wew Favorkes Toos Help

Qo - © - | Psewt [ rotes | (-

Pick a category

|

See Also -«

% Windons Lpdate

B Swicch to Classic view

 J
" Network and Internet Connections

-
| Yra—

Al ¢))| Sounds, Sneech, and audio Devices

Go to [System] — [Hardware] — [Driver Signing] — [File
Signature Verification], and check the radio button to the left
of “Ignore -Install all files, regardless of file signature” and
click [OK].

4 Click the [OK] button to close System Properties, and then
click “X” in the upper right of the window to close the Con-
trol Panel.

Insert the included CD-ROM into the CD-ROM drive.

Make sure the POWER switch on the MIDI instrument is set
to OFF and use the USB cable to connect the USB terminal of
the computer to the USB terminal of the MIDI instrument.
‘When the MIDI instrument is turned on, the computer auto-
matically displays the “Found New Hardware Wizard.”

O\h

7 Check the radio button to the left of “Search for a suitable
driver for my device. (Recommended).” Click [Next].
The system starts the installation.

8 When the installation is complete, the system displays “Com-
pleting the Found New Hardware Wizard.” Click [Finish].

#9 NOTE

» Some computers may take about ten seconds to show this screen
after the installation is complete.

9 Restart the computer.
The driver has been installed.

M File Utility

Once you’ve installed these software programs, you can use your
computer to organize data saved to the User/FD/HD drive in the
MIDI instrument.

' Double-click on the “FileUtil_" folder in the CD-ROM.
The file “setup.exe” will be displayed.

Double-click on the “setup.exe” file.
The MIDI instrument Tools setup dialog will be displayed.

3 Execute the installation by following the on-screen directions.

For details, refer to the on-line Help or the PDF owner’s manual.

MIDI port setting (when starting the
software as a stand-alone application)

Before setting the MIDI port on the File Utility, you should set the
MIDI port from the MIDI SETUP toolbar.

#9 NOTE

» When you start the File Utility as a plug-in application in the Open Plug-in
Technology compatible application, refer to the the PDF manual for the
respective software.

J start the File Utility.

2 Click the MIDI Setup button in the Toolbar called up via step
#1.

PN
‘ J( ME%ITUP

MIDI Setup button

In the MIDI Setup window called up via step #2, click the
[¥] button at the right end of each box and make the port set-
tings as shown.

bHA LISE IM 0-1

thru

MOME |
ok I Cancel Help

#9 NOTE
« In order for MIDI ports to be available here, you'll need to select the rele-
vant MIDI port within File Utility. This is the port that will be used in the rel-
evant MIDI applications. For details on setting the MIDI port, refer to the
on-line manual of File Utility.
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For Macintosh Users

Software Installation

H Acrobat Reader

In order to view the electronic (PDF) manuals included with each
application, you’ll need to install Acrobat Reader.

' Double-click on the “Acroread_" folder.
Four different language folders will be displayed: English,
German, French and Spanish.

2 Select the language you want to use and double-click on its
folder.
“Reader Installer” will be displayed.
The Installer name may differ depending on the language you
select.

3 Double-click on the “Reader Installer.”
Acrobat Reader Setup Dialog will be displayed.

4 Execute the installation by following the directions appearing
on the screen.
After installation is complete, the Acrobat folder appears on
your computer (in Hard Disk, as the default).
For information on using the Acrobat Reader, refer to the
Reader Guide in the Help menu.

B Open Music System (OMS)

OMS allows you to use several MIDI applications on the Mac OS
at the same time.

' Double-click on the “OMS_" folder (English version only).
“Install OMS *****> will be displayed.

2 Double-click on “Install OMS *#3##% >
OMS Setup Dialog will be displayed.

3 Execute the installation by following the on-screen directions.
After the installation, select “Restart.”

Z7 NOTE

« After the installation is complete, you may possibly encounter an
error message warning that the installer did not close. In this case,
go to the “File” menu and select “Quit” to close the installer. Then
reboot the computer.

After restarting the Macintosh, you will find the “Opcode”/
“OMS Applications” folder on your computer (Hard Disk, as
the default).

4 Copy the “OMS_***_Mac.pdf” in the CD-ROM to the
“OMS Applications” folder (drag-and-drop it to the folder).
Refer to the “OMS_***_Mac.pdf” (English version only)
how to use the application.

5 Copy the “OMS Setup for YAMAHA” in the CD-ROM to the
“OMS Applications” folder (drag-and-drop it to the folder).
In the “OMS Setup for YAMAHA” folder you will find the
OMS Setup files for the Yamaha tone generators, which can
be used as templates.

Bl USB MIDI Driver

To operate the MIDI instrument from your computer via USB,
you’ll need to install the appropriate driver software.

The USB-MIDI driver is software that transfers MIDI data back
and forth between sequence software and the MIDI instrument via
a USB cable.

Computer

MIDI instrument

USB cable o |:| _

5= e — R

Sequence
Software

[T
[

C
C

e} ggo#gg = O

o= 50 TN

First install OMS before you install the USB-MIDI driver. Also,
after installing the driver, you will need to set up OMS (see page
7).

' Start the computer.

2 Insert the included CD-ROM into the CD-ROM drive. The
system displays the CD-ROM icon on the desktop.

3 Double-click the CD-ROM icon and double-click the “Install
USB Driver” icon in the “USBdrv_" folder to display the fol-
lowing installation screen.

=————————  InstallVsBDriver=—-——§&

Click “Install” button to install USB Driver.

— Install Location

MacintoshHD2 = Quit
on the disk “Macintosh HD 2 (Lswitch bisk | [[_mstan_J|

4 The “Install Location” box displays the destination of the
installation. If you wish to change the destination disk or
folder, use the [Switch Disk] button and the pop-up menu to
specify the desired destination.

#0 NOTE

« This box usually displays the start-up disk as the destination.

5 Click the [Install] button. The system displays the following
message: “This installation requires your computer to restart
after installing this software. Click Continue to automatically
quit all other running applications.” Click [Continue].

#7 NOTE

« To cancel the installation, click [Cancel].
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For Macintosh Users

The installation starts. If the driver has already been installed,
the following message appears. To return to step #3, press
[Continue]. To complete the installation, click [Quit].

Install USB Driver
Clicl

s No installation was necessary. The files to be
installed are already on your disk, or are not
needed for your hardware setup.
Ifyou are finished, click Quit to leave the
Installer. If you wish to perform additional
installations, click Continue.

— T Select folder |

on the disk *Mazintosh HD * aa

7 When the installation is complete, the system displays the fol-
lowing message: “Installation was successful. You have
installed software which requires you to restart your com-
puter.” Click [Restart]. The computer automatically restarts.
You can locate the installed files in the following locations:

¢ [System Folder] — [Control Panels] — [YAMAHA USB
MIDI Patch]

« [System Folder] — [Extensions] — [USB YAMAHA
MIDI Driver]

« [System Folder] — [OMS Folder] — [YAMAHA USB
MIDI OMS Driver]

M File Utility

Once you’ve installed the File Utility, you can use your computer
to access and organize data saved to the User/FD/HD drive in the
MIDI instrument.

Double-click on the “FileUtil_" folder in the CD-ROM.
“Install File Utility” file will be displayed.

Double-click on the “Install File Utility” file.
The File Utility installation dialog will be displayed. Execute
the installation by following the on-screen directions.

3 After installing, restart the computer.

For details, refer to the on-line Help or the PDF owner’s manual.

Setting up OMS

The OMS studio setup file for the MIDI instrument is contained in
the included CD-ROM. This studio setup file is used for setting up
OMS.

#9 NOTE

« Before performing the following procedure, the OMS and USB MIDI Driver
should be installed (see page 6).

, Use a USB cable to connect the USB terminal of the com-
puter to the USB terminal of the MIDI instrument and turn
the MIDI instrument’ power on.

2 Start the computer.

3 Insert the included CD-ROM into the CD-ROM drive of your
Macintosh computer.
The CD-ROM icon appears on the desktop.

4 Double-click on the CD-ROM icon, “OMS_", and “OMS
Setup for YAMAHA.”
The file “****-USB” appears. (‘“****” indicates the product
name, etc.) Copy this to the hard disk on your computer.

Double-click on the “****-USB” file to start the OMS Setup.

After starting the OMS Setup, the Studio setup file double-
clicked in step #5 opens.

O\

Indicates this setup is available

O =—X{¢C)avinova-USB =——=HB

X2 USE-MIk] 1

] “m Clavihoa-1
m

Ew| |

Clavinea-2

SIEID

g D) NOTE

« The name of the title and port may differ depending on the particular
model used.

« If “> is not indicated at the right of the setup file name, select
“Make Current” from the “File” menu and execute the save opera-
tion.

The OMS studio setup has been completed.

#9 NOTE

« After the OMS studio setup above has been completed, your computer will
recognize only the MIDI instrument as a MIDI instrument. If you use
another MIDI instrument in addition to the MIDI instrument or you add a
second MIDI instrument to the existing system, you should create an origi-
nal Studio Setup file. For details, refer to the on-line manual supplied with
the OMS.
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For Macintosh Users

Depending on the Macintosh and operating system version
that you are using, the included studio setup file for the MIDI
instrument still may not work even after you have performed
the above steps. (MIDI transmission and reception will not be
possible even if the setup is valid.)

In this case, use the following procedure to re-create the setup
file.

1 Connect the MIDI instrument and Macintosh via USB
cable, and turn on the power of the MIDI instrument.

2 Start up OMS Setup, and from the “File” menu, choose
“New setup.”

3 The OMS driver search dialog box will appear.
Uncheck both [Modem] and [Printer] if you are using a
USB connection.

4 Click the [Find] button to search for the device.
When a device has been found, the OMS Driver Setting
dialog box will display “USB-MIDI.”

« If the device was found correctly, click the [OK]
button to proceed.

« If the device was not found, re-check that the cable
connections are correct, and repeat the procedure
from step #1.

5 Make sure that the port is shown below the device that
was found. (This will be a name such as USB-MIDI.)
Check the check box for the port, and then click the
[OK] button.

6 A dialog box will appear, allowing you to name the file
that will be saved. Input the desired filename, and click
[Save].

This completes the OMS setup.

7 From the “Studio” menu, choose “Test,” and click the
port icon.
If a channel sounds on the MIDI instrument, the system
is operating correctly.

For details on using OMS, refer to “OMS_***_Mac.pdf,”
included with OMS.
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Troubleshooting

The driver cannot be installed.

* Is the USB cable connected correctly?
— Check the USB cable connection.
— Disconnect the USB cable, then connect it again.

Windows

« Is the USB function enabled on your computer?

— When you connect the MIDI instrument to the computer for
the first time, if the “Add New Hardware Wizard” does not
appear, the USB function on the computer may be disabled
(see pages 3, 4). Perform the following steps.

1 Select [Control Panel] — [System] — [Device Manager]
(for Windows 98/Me), or select [Control Panel] (Windows
XP: Classic View) — [System] — [Hardware] — [Device
Manager] (for Windows 2000/XP).

2 Make sure that no “!” or “x” marks appear at “Universal
serial bus controller” or “USB Root Hub.” If you see an
“I” or “x”” mark, the USB controller is disabled. For more
information, refer to the owner’s manual of your com-

puter.

Windows

* Is any unknown device registered?

— If driver installation fails, the MIDI instrument will be marked
as an “Unknown device,” and you will not be able to install the
driver. Delete the “Unknown device” by following the steps
below.

1 Select [Control Panel] — [System] — [Device Manager]
(for Windows 98/Me), or select [Control Panel] (Windows
XP: Classic View) — [System] — [Hardware] — [Device
Manager] (for Windows 2000/XP).

2 Look for “Other devices” in the menu “View devices by
type.”

3 If you find “Other devices,” double-click it to extend the
tree to look for “Unknown device.” If one appears, select it
and click the [Remove] button.

4 Remove the USB cable from the MIDI instrument, and
make the connection again.

5 Install the driver again.

— Windows 98/Me users See page 3.
— Windows 2000 users See page 4.
— Windows XP users See page 5.

When controlling the MIDI instrument from
your computer via USB, the MIDI instrument
does not operate correctly or no sound is
heard.

* Did you install the driver?
— Windows users See page 3.
— Macintosh users See page 6.

* Is the USB cable connected correctly?

* Are the volume settings of the tone generator, playback
device, and application program set to the appropriate lev-
els?

» Have you selected an appropriate port in the sequence
software?

* Are you using the latest USB MIDI driver?
—> The latest driver can be downloaded from the following web site.
http://www.yamahasynth.com/

Playback response is delayed.

» Does your computer satisfy the system requirements?
« Is any other application or device driver running?

Macintosh

— Turn off virtual memory.
— Disable AppleTalk.

Cannot suspend or resume the computer cor-
rectly.

*» Do not suspend the computer while the MIDI application is
running.

« If you are using Windows 2000, you may not be able to sus-
pend/resume normally, depending on the particular envi-
ronment (USB Host Controller, etc.). Even so, simply
disconnecting and connecting the USB cable will allow you
to use the MIDI instrument functions again.

| How can | delete or re-install the driver?

Windows Me/98

1 When the MIDI instrument is recognized correctly, dou-
ble-click “System” in the Control Panel to open the Sys-
tem window.

Double-click the “Device Manager” tab, select
“YAMAHA USB MIDI Driver” and delete it.

Use the MS-DOS prompt or Explorer to delete the follow-
ing three files.

«\WINDOWSNINFNOTHER\YAMAHAMIDI instru-
ment.INF

«\WINDOWS\SYSTEM\X gusb.drv

* \WINDOWS\SYSTEM\Y midusb.sys

#7 NOTE

« To delete the above files using Explorer, select “Folder Options” from
the Tool (View) menu, and select “Show all files (and folders).”

4] Disconnect the USB cable.
5 Restart the computer.

6 Re-install the driver (see page 3).

Macintosh
, Delete the files in the following locations:

* [System Folder] — [Control Panels] = [YAMAHA
USB MIDI Patch]

* [System Folder] — [Extensions] — [USB YAMAHA
MIDI Driver]

* [System Folder] — [OMS Folder] — [YAMAHA
USB MIDI OMS Driver]

2 Restart the computer.

3 Install the driver (see page 6) and set up OMS (see page
7).
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SOFTWARE LICENSING AGREEMENT

The following is a legal agreement between you, the end user, and Yamaha Corporation (‘“Yamaha”). The enclosed Yamaha software program
is licensed by Yamaha to the original purchaser for use only on the terms set forth herein. Please read this licensing agreement with care.
Opening this package indicates that you accept all terms outlined herein. If you do not agree to the terms, return this package unopened to
Yamabha for a full refund.

1. GRANT OF LICENSE AND COPYRIGHT

Yamaha grants you, the original purchaser, the right to use one copy of the enclosed software program and data (“SOFTWARE”) on a single-
user computer system. You may not use it on more than one computer or computer terminal. The SOFTWARE is owned by Yamaha and is
protected by Japanese copyright laws and all applicable international treaty provisions. You are entitled to claim ownership of the media in
which the SOFTWARE is included. Therefore, you must treat the SOFTWARE like any other copyrighted materials.

2. RESTRICTIONS

The SOFTWARE program is copyrighted. You may not engage in reverse engineering or reproduction of the SOFTWARE by other
conceivable methods. You may not reproduce, modify, change, rent, lease, resell, or distribute the SOFTWARE in whole or in part, or create
derivative works from the SOFTWARE. You may not transmit or network the SOFTWARE with other computers. You may transfer ownership
of the SOFTWARE and the accompanying written materials on a permanent basis provided that you retain no copies and the recipient agrees
to the terms of the licensing agreement.

3. TERMINATION

The licensing condition of the software program becomes effective on the day that you receive the SOFTWARE. If any one of the copyright
laws or clauses of the licensing conditions is violated, the licensing agreement shall be terminated automatically without notice from Yamaha.
In this case, you must destroy the licensed SOFTWARE and its copies immediately.

4. PRODUCT WARRANTY

Yamaha warrants to the original purchaser that if the SOFTWARE, when used in normal conditions, will not perform the functions described
in the manual provided by Yamaha, the sole remedy will be that Yamaha will replace any media which proves defective in materials or
workmanship on an exchange basis without charge. Except as expressly set forth above, the SOFTWARE is provided “as is,” and no other
warranties, either expressed or implied, are made with respect to this software, including, without limitation the implied warranties of
merchantability and fitness for a particular purpose.

5. LIMITED LIABILITY

Your sole remedies and Yamaha'’s entire liability are as set forth above. In no event will Yamaha be liable to you or any other person for any
damages, including without limitation any incidental or consequential damages, expenses, lost profits, lost savings or other damages arising
out of the use or inability to use such SOFTWARE even if Yamaha or an authorized dealer has been advised of the possibility of such damages,
or for any claim by any other party.

6. GENERAL

This license agreement shall be interpreted according to and governed by Japanese laws.
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SOFTWARE-LIZENZVEREINBARUNG

Die folgende Vereinbarung ist eine rechtsgiiltige Vereinbarung zwischen Ihnen, dem Endanwender, und der Yamaha Corporation (‘““Yamaha”).
Yamabha erteilt dem urspriinglichen Kiufer fiir das beiliegende Yamaha-Softwareprogramm ausschlieflich zu den hier ausgefiihrten
Bedingungen eine Lizenz zur Verwendung. Bitte lesen Sie diese Lizenzvereinbarung sorgfiltig. Durch das Offnen dieser Packung bringen Sie
zum Ausdruck, daf} Sie alle darin enthaltenen Bedingungen akzeptieren. Wenn Sie nicht mit den Bedingungen einverstanden sind, konnen Sie
die Packung ungeoffnet an Yamaha zuriickgeben; der Kaufpreis wird in voller Hohe zuriickerstattet.

1. ERETILUNG VON LIZENZ UND COPYRIGHT

Yamaha erteilt Thnen, dem urspriinglichen Kaufer, das Recht, ein Exemplar des beiliegenden Softwareprogramms und der darin enthaltenen
Daten (“SOFTWARE”) als Einzelperson auf jeweils einem Computer zu verwenden. Sie diirfen sie nicht auf mehr als einem Computer bzw.
einer Computerstation verwenden. Die SOFTWARE bleibt im Besitz von Yamaha und ist durch japanische Copyrightgesetze sowie alle
anwendbaren internationalen Vertragsbestimmungen geschiitzt. Sie haben ein Anspruchsrecht auf das Eigentum an den Medien, denen die
SOFTWARE beiliegt. Daher miissen Sie die SOFTWARE wie alle anderen durch Copyright geschiitzten Materialien behandeln.

2. EINSCHRANKUNGEN

Die SOFTWARE ist durch Copyright geschiitzt. Sie diirfen Sie weder analysieren noch durch anderweitige Methoden reproduzieren. Sie
diirfen die SOFTWARE weder ganz noch teilweise reproduzieren, modifizieren, verdndern, gegen Entgelt oder unentgeltlich verleihen,
verkaufen oder vertreiben, und Sie diirfen auf der Grundlage der SOFTWARE keine Ableitungen erstellen. Sie diirfen die SOFTWARE nicht
an andere Computer senden oder in Netzwerke einspeisen. Sie diirfen das Eigentum an der SOFTWARE und den schriftlichen
Begleitmaterialien auf unbefristeter Basis unter den Voraussetzungen iibertragen, daf} Sie keine Kopien zuriickbehalten und sich der
Empfianger mit den Bedingungen der Lizenzvereinbarung einverstanden erklart.

3. BEENDIGUNG

Deutsch

Die Lizenzbedingung des Softwareprogramms wird am Tag, an dem Sie die SOFTWARE erhalten, wirksam. Falls ein Copyrightgesetz oder
eine Bestimmung der Lizenzbedingungen verletzt wird, wird automatisch und ohne Benachrichtigung durch Yamaha die Lizenzvereinbarung
beendet. In diesem Fall miissen Sie die lizensierte SOFTWARE und ihre Kopien unverziiglich vernichten.

4. PRODUKTGARANTIE

Yamaha garantiert dem urspriinglichen Kiufer, daB, falls die SOFTWARE bei Verwendung unter normalen Bedingungen nicht die in der von
Yamaha bereitgestellten Anleitung beschriebenen Funktionen erfiillt, die einzige Abhilfe darin bestehen wird, dal Yamaha auf Austauschbasis
kostenlos jedes Medium ersetzen wird, das Material- oder Verarbeitungsfehler aufweist. Abgesehen von dem oben Ausgefiihrten wird die
SOFTWARE “wie die Ware liegt und steht” geliefert, und es werden keine anderen ausdriicklichen oder stillschweigenden Garantien
hinsichtlich dieser Software iibernommen, einschlielich, aber nicht beschrénkt auf, die stillschweigenden Garantien fiir handelsiibliche
Qualitit und Eignung fiir einen bestimmten Einsatzzweck.

5. BESCHRANKTE HAFTUNG

Thre einzige Abhilfe und die gesamte Haftung Yamahas bestehen in dem oben Ausgefiihrten. Keinesfalls haftet Yamaha Thnen oder einer
anderen Person gegeniiber fiir etwaige Schiden, einschlieBlich, aber nicht beschrinkt auf, zufillige Schiden oder Folgeschidden, Kosten,
Verdienstausfall, verlorene Ersparnisse oder andere Schadenersatzanspriiche, die aus der Verwendung der SOFTWARE oder aus der Tatsache
hervorgehen, daf3 diese SOFTWARE nicht verwendet werden konnte, selbst wenn Yamaha oder ein autorisierter Hiandler tiber die Moglichkeit
derartiger Schadenersatzanspriiche informiert wurde, oder fiir etwaige andere Anspriiche einer anderen Partei.

6. ALLGEMEINES

Diese Lizenzvereinbarung soll gemiB und in Ubereinstimmung mit den japanischen Gesetzen ausgelegt werden.
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CONTRAT DE LICENCE DE LOGICIEL

Ceci est un contrat entre vous-méme, 1’utilisateur final, et Yamaha Corporation (« Yamaha »). Le logiciel Yamaha ci-inclus est concédé sous
licence par Yamaha a I’acheteur original et ne peut étre utilisé que dans les conditions prévues aux présentes. Veuillez lire attentivement ce
contrat de licence. Le fait d’ouvrir ce coffret indique que vous acceptez I’ensemble des termes du contrat. Si vous n’acceptez pas lesdits
termes, renvoyez le coffret non ouvert & Yamaha pour en obtenir le remboursement intégral.

1. CONCESSION DE LICENCE ET DROITS D’AUTEUR

Yamaha vous concede le droit d’utiliser, en tant qu’acheteur original, un exemplaire du logiciel et des données afférentes a celui-ci

(« LOGICIEL ») sur un ordinateur pour utilisateur unique. Vous n’€tes pas autorisé a utiliser ces éléments sur plus d’un ordinateur ou terminal
d’ordinateur. Le LOGICIEL est la propriété de Yamaha. Il est protégé par les dispositions relatives au droit d’auteur contenues dans la
législation japonaise et les traités internationaux. Vous étes en droit de revendiquer I’appartenance du support du LOGICIEL. A ce titre, vous
devez traiter le LOGICIEL comme tout autre élément protégé par le droit d'auteur.

2. RESTRICTIONS

Le LOGICIEL est protégé par le droit d’auteur. Vous n’étes pas autorisé a reconstituer la logique du LOGICIEL ou a reproduire ce dernier par
quelque autre moyen que ce soit. Vous n’€tes pas en droit de reproduire, modifier, préter, louer, revendre ou distribuer le LOGICIEL en tout ou
partie, ou d’utiliser le LOGICIEL a des fins de création dérivée. Vous n’étes pas autorisé a transmettre le LOGICIEL a d’autres ordinateurs ou
a I'utiliser en réseau.

Vous étes en droit de céder, a titre permanent, le LOGICIEL et la documentation imprimée qui I’accompagne, sous réserve que vous n’en
conserviez aucun exemplaire et que le bénéficiaire accepte les termes du présent contrat.

3. RESILIATION

Les conditions énoncées dans le présent contrat de licence prennent effet a compter du jour ot le LOGICIEL vous est remis. Si 1’une
quelconque des dispositions relatives au droit d’auteur ou des clauses du contrat ne sont pas respectées, le contrat de licence sera résilié de
plein droit par Yamaha, ce sans préavis. Dans ce cas, vous devrez immédiatement détruire le LOGICIEL concédé sous licence ainsi que les
copies réalisées.

ol

4. GARANTIE PRODUIT

Si, dans des conditions normales d’utilisation, le LOGICIEL ne remplit pas les fonctions décrites dans le manuel fourni, Yamaha s’engage vis-
a-vis de I’acheteur original a remplacer gratuitement, sur la base d’un échange, tout support reconnu défectueux par suite d’un défaut de
matiere premiere ou d’un vice de fabrication. Ceci constitue le seul recours opposable a Yamaha. Hormis dans les cas expressément énoncés
plus haut, le LOGICIEL est livré « en 1’état » et toute autre garantie expresse ou implicite le concernant, y compris, de maniere non limitative,
toute garantie implicite de qualité marchande et d’adéquation a un usage particulier, est exclue.

S
S
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5. RESPONSABILITE LIMITEE

Votre unique recours et la seule responsabilité de Yamaha sont tels qu’énoncés précédemment. En aucun cas Yamaha ne pourra étre tenu
responsable, par vous-méme ou une autre personne, de quelques dommages que ce soit, notamment et de maniére non limitative, de dommages
indirects, frais, pertes de bénéfices, pertes de fonds ou d’autres dommages résultant de 1’utilisation ou de 1’'impossibilité d’utiliser le
LOGICIEL, méme si Yamaha ou un distributeur agréé ont été prévenus de I’éventualité de tels dommages, ou de quelque autre revendication
formulée par une tierce partie.

6. REMARQUE GENERALE

Le présent contrat de licence est régi par le droit japonais, a la lumiere duquel il doit étre interprété.
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CONTRATO DE LICENCIA DE SOFTWARE

El presente es un acuerdo legal entre usted, el usuario final, y Yamaha Corporation (“Yamaha”). El programa Yamaha incluido est4 licenciado
por Yamaha al comprador original para utilizar inicamente segtin los términos establecidos aqui. Lea atentamente este contrato de licencia. La
apertura de este paquete supone la aceptacion de todas las condiciones descritas aqui. Si no acepta los términos de este acuerdo, devuelva este
paquete intacto a Yamaha para una devolucion total del importe pagado.

1. CESION DE LICENCIA Y COPYRIGHT

Yamaha cede, al comprador original, el derecho a utilizar una copia del programa e informacioén incluidos (“SOFTWARE”) en un sistema
informatico de un solo usuario. No puede utilizarlo en mds de un ordenador o terminal. El SOFTWARE es propiedad de Yamaha y estd
protegido por las leyes japonesas de copyright y por todas las provisiones de los tratados internacionales de copyright. Tiene derecho a
reclamar la propiedad del soporte en el que se incluye el SOFTWARE. Por consiguiente, debe considerar el SOFTWARE de igual forma que
otros materiales sujetos a copyright.

2. RESTRICCIONES

El SOFTWARE esta sujeto a copyright. No debe desmontar ni analizar el SOFTWARE por otros métodos concebibles. No puede reproducir,
modificar, cambiar, alquilar, arrendar, revender, o distribuir el SOFTWARE, en todo o en parte, o crear trabajos derivados del mismo. No puede
transmitir ni utilizar en red el SOFTWARE con otros ordenadores. Puede transferir la propiedad del SOFTWARE y los materiales escritos que

acompaiian al mismo de forma permanente siempre que no realice copias y que el destinatario acepte los términos de este acuerdo de licencia.

3. FINALIZACION

La condicién de licencia del programa es efectiva en el dia que reciba el SOFTWARE. Si se infringe alguna de las leyes o cldusulas de
copyright de las condiciones de licencia, el acuerdo de licencia se considerara finalizado de forma automaética sin previo aviso por Yamaha. En
este caso, debe destruir el SOFTWARE con licencia y sus copias inmediatamente.

4. GARANTIA DEL PRODUCTO

Yamaha garantiza al comprador original que si el SOFTWARE, utilizado en condiciones normales, no realiza las funciones descritas en el
manual proporcionado por Yamaha, lo tinico que hard Yamaha serd sustituir cualquier soporte que sea defectuoso, tanto en lo que se refiere a
materiales como a mano de obra, cambidndolo sin cargo alguno. Excepto en los términos anteriores, el SOFTWARE se entrega “tal cual,” y sin
garantias de ningun tipo, expresas o implicitas, incluyendo, sin limitaciones las garantias implicadas de comerciabilidad y de conveniencia
para un propésito particular.

5. RESPONSABILIDAD LIMITADA

Su tnico recurso y la total responsabilidad de Yamaha son los anteriormente establecidos. En ningtin caso Yamaha serd responsable ante el
usuario o ante cualquier otra persona por dafios, sin limitaciones de dafios indirectos o imprevistos, gastos, pérdidas, u otros dafios causados
por el uso o la poca habilidad en el uso de dicho SOFTWARE aunque Yamaha o un distribuidor autorizado le haya advertido de la posibilidad
de estos dafios, o reclamaciones de cualquier otra parte.

6. GENERAL

Este acuerdo de licencia se rige y elabora de acuerdo con las leyes japonesas.

Esparniol
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